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OVERVIEW

The importance of data from contraceptive self-injection and other self-care approaches

Data has the power to convey the lived experiences of women and adolescents, highlighting the 

importance and potential of expanding choices to reduce unmet need for contraception. Contraceptive 

self-injection (SI) data is often missing in routine family planning measurement and evaluation. The 

Subcutaneous depot medroxyprogesterone acetate (DMPA-SC) Access Collaborative has developed this 

resource to support family planning programs in tracking progress with SI scale up, thereby advancing a 

broad contraceptive method mix and quality of care, and influencing policy development and 

procurement planning across public and private sectors. 

The purpose of this tool

This is part of a monitoring, learning, and evaluation (MLE) toolkit of three tools: the data use and 

indicators guide, data visualization principles, and Excel dashboard: how-to guide for dynamic decision-

making tools are primers in how to create dynamic and visually compelling self-injection program data 

displays (e.g., dashboards, presentations) that facilitate comprehension and use of SI data for family 

planning program decision-making. While this tool was developed with DMPA-SC self-injection in mind, 

many of these principles could be applied to data visualization needs across family planning programs 

and methods.

Who should use this tool

All three tools are intended for use by individuals who will be presenting SI data to senior family planning 

program decision-makers. These individuals should have some experience with basic data manipulation 

(e.g., HMIS focal people) and could be at the central, regional, or district level of the health system or an 

implementing partner.

Where to find other tools in the MLE toolkit

Please visit the DMPA-SC Resource Library at www.FPoptions.org to access the full MLE toolkit, Toolkit 

for DMPA-SC monitoring, learning, and evaluation.

About the DMPA-SC Access Collaborative

The PATH-JSI DMPA-SC Access Collaborative provides data-driven technical assistance, coordination, 
resources, and tools to ensure that women have increased access to DMPA-SC self-injection as part of 
an expanded range of contraceptive methods, delivered through informed choice programming.

The content in this document may be freely used for educational or noncommercial purposes, provided 
that the material is accompanied by an acknowledgement line.

www.path.org/DMPA-SC | www.FPoptions.org | FPoptions@path.org

http://www.fpoptions.org/
http://www.path.org/DMPA-SC
http://www.fpoptions.org/
mailto:FPoptions@path.org


ontents

Introduction

Structuring & Organizing Data

Data Validation

Data Visualization

Dynamic Rank Table

Pivot Tables & Charts

Formatting Graphs & Charts

Designing Your Dashboard

Additional Resources

CONTENTS

3

4

5

6

7

8

13

18

21

22



INTRODUCTION
This toolkit is a guide on how to produce a simple dashboard using DMPA-SC self-injection data. The Excel 

guide has an accompanying Access Collaborative sample dataset. The dashboard is designed to visualize 

key indicators to monitor implementation of SI introduction and scale-up programs. Dashboards are ways 

to visualize key data points and allow users to interact with that data to gain further knowledge to support 

decision-making. The following is a snapshot of the end product we will create throughout the chapters of 

this guide. 

The sample dataset consists of three tables, namely: 

• Uptake Data – A table with 2,240 observations and five variables: sub-national unit, reporting 

month, indicator, injectable, and value. The indicators captured are number of visits, percent of 

SDPs stocked out of DMPA-SC among those providing the product, and percent of SDPs actively 

offering SI.

• Training Data – This table contains 184 observations and eight variables: sub-national, quarter, 

sector, target, actual, training focus, training type, and year.

• Context Data – This table has country context information. It has 14 records and two variables: 

context indicator and value.
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STRUCTURING & ORGANIZING DATA

When you are working with a lot of data it is easy for Excel to get out of control. Excel workbooks can 

quickly become big, messy files that are hard to navigate. In order to set yourself up for a variety of 

potential analyses, it is important to organize your data into sustainable and dynamic data structures that 

can feed seamlessly into Excel’s analytical features, such as pivot tables and charts. 

To take full advantage of the dynamic data features in Excel, your data structure cannot have merged cells 

or blank rows/columns. Additionally, cells also cannot contain multiple distinct pieces of data in the same 

cell. Each row of your data should contain only one value. If a row contains more than one value, it is 

difficult for Excel to summarize, calculate and analyze the data. Disaggregated data such as age, region, 

and date should be entered in columns. Each value should have an associated age, region, and date. This 

results in a long dataset rather than a wide dataset. 

Before
Merged Cells

After
Merged Cells

Blank Sections Blank Sections

Multiple Data Pieces in a Cell Multiple Data Pieces in a Cell 
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DATA VALIDATION

• Data validation is a feature in Excel that allows you to control the type of data entered into a cell. It has 

a few purposes and is extremely relevant during data collection and entry to ensure consistent and 

clean data. 

• Additionally, and for our purposes, data validation can also act as a filter, similar to slicers which will be 

introduced later. For this dashboard, we want to create a dropdown list of years to filter our training 

data rank table. 

• In your workbook, create a new tab and rename it Dashboard. First, select the cell where the 

dropdown will be, M3. Then on the Data tab at the top, click on Data Validation. 

• In the pop-up box, under Allow, select List. 

• For Source, we can manually enter values or select a range in our workbook. For this we will 

type in our years: 2018, 2019, 2020. Then click OK and test it out!  Alternatively, click Source 

then select the cells in your workbook that contain your list. 

Dropdown should look like this afterTypically, we would add a dashboard component later in 

the development process once we know what our layout 

will be. However, we need this dropdown in the dynamic 

rank table we will build in our first visualization. 

Be sure to select one of the years 
before moving to the next step. 

6



DATA VISUALIZATION

There are a number of ways to display your data in Excel. However, your audience is more likely to grasp 

what you want to convey if the information is shared using charts. In this section, you will learn to use 

Excel charts to enable you to present your analysis with emphasis. Throughout this exercise, we will use 

Access Collaborative’s sample dataset.xlsx to create an informative dashboard. 

The following graphic shows the common elements available on Excel charts. These elements will be 

referenced throughout the rest of this guide as we build and develop our dashboard. 

Chart Elements
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DYNAMIC RANK TABLE
In this section, we will create the first visualization – a training achievement ranking shown on the dashboard. 

The dynamic rank table we create will help in visualizing the percentage of DMPA-SC training targets achieved 

for each subnational unit, ranked from highest to lowest for the selected time period. Using formulas for a 

dynamic table is an alternative to pivot tables. 

Creating Helper Sheet

• Insert a new worksheet tab and rename it to Helper. We use the Helper tab to calculate all of the formulas. 

Having a ‘Helper’ tab ensures there are fewer formulas on the dashboard to break due to accidental user 

error. Additionally, when using formulas you might have to use more information than what will ultimately be 

visualized. 

• Create a list of all the subnational units in our dataset. In order to not miss any, we will use the Remove 

Duplicates feature. First, copy column A (subnational unit) of Uptake Data and paste it into Column A in the 

Helper worksheet. 

• While the column A of the Helper sheet is highlighted, navigate to Data and choose Remove Duplicates. 

Check the box My data has headers in the subsequent dialogue. You should now get the distinct nine 

subnational units.

• The data displayed in this helper table needs to change based on a selected value, Date. To do this we need 

to pull in all related data elements to calculate the percent of the training target achieved. Type Target, 

Actual, % Achieved, and Rank in cells B1, C1, D1, and E1 respectively. Using the training data table, we want 

to summarize the information by subnational unit.

• To pull in the information we are looking for, we will use the SUMIFS formula which sums values based on 

criteria. In cell B2 of the Helper worksheet type the formula below and autofill or drag for all subnational 

units. The formula below returns each subnational unit’s training target. We will use the same formula in 

column C except we replace the training target with the Training_actual value.

=SUMIFS(TrainingData[field_target], TrainingData[Subnational Unit], Helper!A2, TrainingData[field_year], 

Dashboard!$M$3)

=SUMIFS(TrainingData[field_actual], TrainingData[Subnational Unit], Helper!A2, TrainingData[field_year], 

Dashboard!$M$3)

=SUMIFS(TrainingData[field_target], TrainingData[Subnational Unit], Helper!A2, TrainingData[field_year], Dashboard!$M$3)

sum_range is the value we 
want to sum or display in the 
cell. For this example, it is the 

training target

Criteria_range1, criteria1 is the criteria we 
want to sum by. For us, it is the 

subnational unit in the first column. The 
Helper!A2 reference will change as we 

drag the formula down

Criteria_range2, criteria2 is the second 
set of criteria. For us, it will be 

referencing the year which we designate 
in cell M3 on the dashboard page. 

Use $ to lock cell references when 

applying a formula to multiple 

columns or rows

Note: if you are receiving errors, be 

sure you have selected a year on 

the dashboard page dropdown. 8



DYNAMIC RANK TABLE

In addition to pivot tables, this first visualization demonstrates the use of formulas to create a dynamic 

table. This helper table will be linked to space on the dashboard. 

• In cell D2 type formula below, format as percent and autofill or drag for all subnational units. The 

formula below calculates the percent of targets achieved for each subnational unit.

• =C2/B2

• Now that we have our percent of training target achieved for each subnational unit based on the 

selected year, we will use the RANK formula to tell us each subnational unit’s rankings based on their 

percent of training achieved.

• =RANK(D2,D$2:D$10)

=RANK(D2,D$2:D$10)

This is what the table should look like:

Number is the value 
we want to evaluate, 

our % achieved

Ref is the range of 
values to compare to 
our number. For us, it 
will be all the values in 

the % achieved 
column

By using formulas for 
these table, the 
information being 
displayed will change 
based on the data we 
have and the filters we 
use without needing an 
intervention by a 
developer.
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DYNAMIC RANK TABLE

• The second part to the Rank table is to set up our data in the right order. The helper table tells us the 

rank of each subnational unit but we want to display only the top five. We will use INDEX and MATCH 

to find the subnational unit to be on the same Helper worksheet, cell A14, B14, C14, and D14 type 

Rank, subnantional unit, Target, Actual, and % Achieved. 

• Insert numbers 1 to 5 in cells A15 to cell A19.

• Since the ranks in our first table will fluctuate based on the data, we need to have a formula that pulls 

in our data in the correct order to display on our dashboard. We will use INDEX and MATCH together to 

do this. 

• In cell C15, type  =VLOOKUP(B15,A$2:E10,2,FALSE) and drag or autofill

• In cell D15, type  =VLOOKUP(B15,A$2:E10,3,FALSE) and drag or autofill

• In cell E15, type =VLOOKUP(B15,A$2:E10,4,FALSE), format as %

• Drag or autofill for the following rows.

INDEX function returns a value or the 
reference to a value from within a table or 
range.

MATCH function searches for a specified 
item in a range of cells, and then returns the 
relative position of that item in the range.

We use INDEX and MATCH 
together to look up the row 

number of the rank from our 
second table in column E of our 
first table then using that row 
number to return the value in 

column A of our first table

=INDEX($A$2:$A$10,MATCH(A15,$E$2:$E$10,0))

• Now that we have the right subnational unit for 

the 1-5 ranks, we need to pull in the other 

information for our table. We can use VLOOKUP

for this. VLOOKUP returns a value in a 

designated column based on a defined value. 

We will look up the training target value from our 

first table based on the subnational unit for the 

first place spot. And repeat for 2-5 rankings. 

In cell B15 enter the following formula:

Copy the formula down through to cell B19

10
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Linking to the Dashboard

• Now that we have our tables built on our Helper tab, we need to have them also display on the 

dashboard. 

• To do this, we will link the cells on the Helper tab to the space we want our table on the dashboard. 

• Let’s manually enter our Rank by typing numbers 1 to 5 starting in cell I6. 

• On the Dashboard tab, select cell J6 type = then navigate to the Helper tab and click where the first 

subnational unit is listed in the rank table. It should be in cell B15. 

• Your formula bar should have the following formula in it: 

• You can drag the formula down to row and across to column M to pull in the rest of the data from the 

Rank Helper table. 

• Consider protecting the cells linked to the Helper tab to reduce the risk of breaking the formulas. 

• To finish this table, add the title “Training achievement ranking” in cell I4. 

• Add heading titles to each of the columns as well. 

• We can make the font of the headers smaller or bigger to help users differentiate the different 

pieces of information being presented in the table. 

• Since this table is mostly text, it might be a good idea to incorporate some visual aspects to help 

display the information. Our next step will be to use conditional formatting to add in-cell bars. 

=Helper!B15

11
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In-Cell Data Bars

• An alternative to creating an Excel chart to 

visualize data is to use conditional 

formatting or sparklines. There are many 

options for conditional formatting including 

data bars. Data bars create a single bar 

chart within a cell.

• To add data bars for our table, highlight 

cells M6 to M10. 

• Under the Home menu choose conditional 

formatting, choose Data Bars and then 

More Rules

• For our data bars, we want to use the first option 

under Rule Type: Format all cells based on their 

values which will add data bars based on the 

value in the cell.

• Then we want to make some adjustments to the 

Rule Description. 

• We want to keep the Format style to Data 

Bar. We have the option to show only the 

bar or keep the data value and bar. 

• Change the type to Number. You may 

need to adjust this based on your data. 

We want out minimum to be 0 and 

maximum to be 1 since we are showing 

percentages. 

• We can change the color of the bar

• Then click OK.

12
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PIVOTTABLES & CHARTS

In this section, we will introduce pivot tables and charts to create dynamic visualizations. The first will be a 

chart to show the trend in uptake of self injection of DMPA-SC as it compares to provider administered 

DMPA-SC.  

Creating PivotTable

• Open the provided dataset.xlsx and navigate to File - Save As – Browse and identify the folder you 

would like to save your workings. Under File name, type Dashboard and under Save as type , choose 

Excel Binary Workbook (*.xlsb) and click Save. Note that saving the workbook as .xlsb makes it a bit 

lighter.

• In the Service Delivery Data worksheet, click anywhere within the data table and navigate to the tool bar 

select Insert – PivotTable. In the pop-up box, make sure your Table Range is referencing your table,

“ServiceDeliveryData” then click OK. This automatically takes you to another page where you can start 

putting the PivotTable together.
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Adding Fields to the PivotTable

To show trends in uptake over time we need a 

number of data elements on our table. When building 

a pivot table, drag your fields into the designated 

areas. In the PivotTable pane, drag the following to 

the appropriate places:  

• Drag Month Year to Rows

• Drag Value to Values

• Drag Indicator to Filters

• Drag Subnational unit to Filters

• Drag Injectable to Column

Our dataset contains data we do not need for this 

chart, such as DMPA-IM data, so we need to filter it 

out. Next to Indicator (i.e. Cell B1), click the carrot 

and choose the appropriate indicators. Only Number 

of visits should be selected. We need to do the same 

for our column labels. Under Column Labels (i.e. cell 

B4), click the carrot and uncheck DMPA-IM. Lastly, 

we must ‘Ungroup” our dates: right click on a Month 

Year then select “Ungroup”.

1. 

2. 

To keep your 
dashboard organized, 
rename Sheet2 (the 
new worksheet 
containing the pivot 
table) to Service 
delivery.

14

PIVOTTABLES & CHARTS



Adding Calculated Fields

• The last component to our first chart is 

to show the percent of DMPA-SC visits 

that were for SI. This data element is 

not in our dataset or indicator list so 

we must calculate it. 

• Select the cell containing DMPA-SC SI 

and under Analyze, choose Calculated 

Item from the Fields, Items & Sets 

dropdown.

PIVOTTABLES & CHARTS

• In the subsequent window we need to name 

and write our calculation. 

• Under Name type %SI

• In the Formula field, enter the formula by 

double clicking from the list of items. 

The characters in red need to be typed 

in. Be sure Injectable is selected under 

Fields

= 'DMPA-SC SI'/( 'DMPA-SC SI' +

'DMPA-SC PA’)

• Click OK

Note that the calculated item above does not work 

for sub or grand totals.

% SI is added as a 
new column in the 

PivotTable
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Adding a PivotChart

• The next step is to add the 

chart to visualize the data in 

our PivotTable. With your 

cursor selected anywhere 

within the PivotTable, 

navigate to the main menu 

under Insert choose 

Recommended Charts. All of 

the possible chart options 

are here for you to select 

from. Since our chart uses 

two types of data, whole 

numbers and percentages, 

we will select a combo chart. 

The combo chart allows dual 

axes to best display the 

scale differences in our data. 

• Under Choose the chart type and axis for your data series in the DMPA-SC PA dropdown, select 

Stacked Column

• Check the Secondary Axis box in the % SI Series 

• Check the chart looks like the sample and click OK

16
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EXERCISE ON YOUR OWN

In this section, you will follow the previous steps to create a PivotTable and line chart to show the percent 

of SDPs offering DMPA-SC and the percent of SDPs stocked out. 

Navigate back to the Uptake data table and insert a new PivotTable. The key elements of this PivotTable 

should be: 

• time period

• percent of SDPs stocked out

• percent of SDPs offering DMPA-SC

• subnational unit. 

After you create your PivotTable, insert a 

PivotChart. Can you change the data values so they 

display as percentages? Are the values in the 

PivotTable logical for our data?

If you feel comfortable, add another pivot table or chart to the dashboard. 

Is there a chart we can create with the Training data?

There are a number of ways and techniques to creating dashboards in Excel. 

This guide is meant to show some but not all of them. Use this time to play 

around and get comfortable with PivotTables and charts. 

17
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not needed for this chart 

(i.e. number of visits)

Hint: If we weren’t filtering 
data by subnational unit 

we might want to 
AVERAGE instead of SUM 
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1 Declutter 2 Title 3 Color

Are there elements of the graph 

that are not fundamental and 

distracting the viewer? Borders, 

gridlines, and tick marks can be a 

default part of charts but should 

be used minimally to create a 

clearer display of data.

Are you clear and succinct, 

telling your reader the key 

takeaway? Use the title to 

express the main story you want 

to share from the data, rather 

than using the title to tell the 

reader the name of the indicator.

Are you using color to highlight 

the important data? Color used 

sparingly helps important data 

stand out. Avoid the trap of 

feeling like you need to use every 

color in your branding guide!  

Also consider black & white 

printing & the colorblind**.

FORMATTING GRAPHS & CHARTS

Declutter: Remove any 
horizontal or vertical 
gridlines on the graph

Declutter: Remove 
any tick marks on the 
vertical and 
horizontal axes

Color: Use a 
neutral color for 
less important 
(comparison) 
categories.

Color: For a featured 
data point, give it a bold 

color to make it stand 
out from the other sets

Title: Add a clear, 
purposeful title that 
gives meaning of data to 
the reader.

As Edward Tufte
said, remove the 
“non-data ink.” 
You only have so 
much space 
available on your 
graph, and you 
want to make 
sure your data 
story comes 
through loud and 
clear!

Data is rich with interesting stories and insights. Have you ever been asked find those stories in your 

analysis, and present them in ways so your audience can quickly understand the key message? This 

section provides  an overview of the power a simple, well designed chart can have.

Designing Your Viz*

*For more detail, read MLE toolkit 2 – Data Viz Principles
**Resource on accessible color palettes: https://towardsdatascience.com/two-simple-steps-to-create-colorblind-friendly-data-visualizations-2ed781a167ec
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Formatting the Chart

• In the resulting graph, right click on 

one of the buttons, Indicator for 

instance and choose Hide all Field 

buttons on chart.

• Under Design, select Quick Layout 

and choose Layout 3.

• Under Design, click on the Add 

Chart Element dropdown and under 

Axis Titles choose Primary Vertical. 

Type number of DMPA visits in this 

primary vertical axis. Repeat the 

procedure and choose Secondary 

Vertical and name this axis to % 

self injecting.

• Explore the other chart elements 

and add Chart Title.

After Formatting

In the Data Viz Principles Guide, we 

mention having meaningful chart 

titles. Typically with dashboards, we 

want descriptive chart titles since the 

data will be filtered and the story will 

likely change.

Right click on the chart then open 

Format Chart Options to see even 

more options for declutter your chart.  

FORMATTING GRAPHS & CHARTS
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Dashboard Layout

• We want to keep our dashboard organized and as clean as possible. There will be a lot of information 

coming at the user at one time and we want them to read through the information logically. We might 

want to start with our national level data at the top half of the dashboard while our subnational data is on 

the second row of the dashboard. 

• Currently, all of our charts are on their respective tabs. We need to copy and paste them onto the 

dashboard. We can resize charts as needed trying to make sure they are consistently sized. 

DESIGNING YOUR DASHBOARD

Formatting the Dashboard

• We can remove gridlines and 

headings to even further clean up 

the space and give the user’s eyes 

a visual break. To do, go to the 

View menu bar and uncheck 

Gridlines and Headings. 

• Insert shapes and text boxes to guide and drive users 

through the different components of the dashboard. 

20
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Adding Functionality with Slicers

• One of the key differences between dashboards and other visualizations is that dashboards are 

interactive and dynamic. Users can select, typically through slicers, to filter out data and visualize a 

subset of the dataset. We use slicers to filter PivotTables. For instance, we may want to see uptake 

and service delivery data for only one subnational unit.

• To insert a slicer, click anywhere inside the PivotTable, navigate to the Analyze tab under PivotTable 

Tools. Then select Insert Slicer.

• Cut and paste the slicer onto the Dashboard page. 

DESIGNING YOUR DASHBOARD

In the pop-up 

box, select the 

Subnational 

unit box.

• We do not want to make the dashboard burdensome and busy for users so instead of having a slicer for 

each of our charts, we can link the slicer we create to the second chart you created during the Exercise. 

• First, right click on 

the Slicer then 

select Report 

Connections. 

• In the pop-up box, 

select the other 

PivotTable to 

connect the two 

charts to the 

slicer. 

It is a best practice to give meaningful names to 
workbook tabs, Tables, and PivotTables to keep 
your work organized.

For Tables and PivotTables, navigate to the left 
of the Tools menu bar and change the name.
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EXCEL GLOSSARY & WEB SEARCHING CHEAT SHEET
A quick reference to Excel technical terms

Term Explanation

Absolute Reference

When using absolute references in macros, it means that when you select or move 
from one cell to another, code is generated that refers to that specific range. 

Another way to think of this is when you are given directions and someone gives you 
the absolute position as a GPS latitude and longitude coordinate no matter where 
you are you will always go to those coordinates.

Data Structure This is an intentional and thoughtful way of organizing data.

Macro
Used to record a series of tasks in Excel. It can expedite data processing and other 
tasks in Excel.

Named Range A named range is just a human-readable name for a range of cells in Excel.

Pivot Chart This is connected to a Pivot Table and it is a visual representation of a Pivot Table. 

Pivot Table

Data summarization tool in Excel that allows you to reorganize selected columns and 
rows of data without changing the structure/organization of the raw data. 

Another way to think of this is as an interactive tool for summarizing large amounts 
of data.

Relative Reference

When you use relative references in macros, it means that when you select or move 
from one cell to another, the  generated code is a reference to a cell in relation to the 
active cell.

Another way to think of this is when you are given directions but where you start 
affects where you end up (like if someone tells you to walk 2 blocks then take a left 
then a right…if you started at a different location you would end up in a different 
location).

VBA Excel based coding language
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RECOMMENDED RESOURCES
For learning about data visualization

If you want to… Check out…

Find Excel tutorials

Beat Excel | http://beatexcel.com/
Udemy | https://www.udemy.com/thebestexcel/
Excel Easy | http://www.excel-easy.com
Browse around on Youtube!

Be inspired by 
great data 
visualizations

Information is Beautiful | informationisbeautiful.net
Flowing Data | flowingdata.com

Improve your 
presentation 
design

AEA Potent Presentations Initiative | p2i.eval.org
Rad Presenters Podcast | radpresenters.com
Lea Pica | leapica.com

Slideology | Nancy Duarte
Resonate | Nancy Duarte

Take a virtual 
course or 
workshop on data 
viz

DIYDataDesign Workshop | diydatadesign.com | Subscription or single workshop 
purchase options focused on building design skills for any level, with virtual, self-paced 
activities and weekly group hangouts
TechChange Introduction to Excel for Data Visualization and Technology for Data 
Visualization courses (or search current offerings and prices at 
techchange.org/online-courses)
Data  Visualization for Development eLearning Course on the Global Health eLearning 
Center | tiny.cc/Ghdataviz | free and tailored for global health professionals
eLearning platforms including Coursera, Lynda, and Udemy all have a number of data 
viz eLearning courses. Explore their catalogues for current offerings!

Read more about 
data visualization 
design

Ann K. Emery | annkemery.com
Alberto Cairo | thefunctionalart.com
Chris Lysy | freshspectrum.com
Cole Naussbaumer | storytellingwithdata.com
Jon Schwabish | policyviz.com
Stephanie Evergreen | stephanieevergreen.com
Free Data+Design eBook | infoactive.co/data-design
Data Viz 101 (focused on chart design best practices) | visage.co/content/data-
visualization-101

Learn from chart 
redesigns

PolicyViz | policyviz.com/remakes
Storytelling with Data | storytellingwithdata.com/gallery

Connect with 
colleagues on data 
viz resources

Data Viz for Development listserv |  DataVizHub.co/join
HelpMeViz to crowdsource data viz expertise
AEA Data Visualization and Reporting Technical Interest Group 
http://comm.eval.org/datavisualizationandreporting/home
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http://annkemery.com/
http://www.thefunctionalart.com/
freshspectrum.com
http://www.storytellingwithdata.com/
policyviz.com
stephanieevergreen.com
http://www.infoactive.co/data-design
visage.co/content/data-visualization-101
http://policyviz.com/remakes/
http://www.storytellingwithdata.com/gallery/
http://www.datavizhub.co/join
http://helpmeviz.com/
http://comm.eval.org/datavisualizationandreporting/home


RECOMMENDED RESOURCES
For building visualizations

If you want to… Check out… So you can…

Figure out what 
chart type to use

Chart Chooser 
labs.juiceanalytics.com/chartchoos
er

Select the type of data story you want to show, 
and see what charts are best fit

Graphic Continuum 
blog.visual.ly/graphic-continuum

See a visual layout of the different chart types 
useful for different relationships

Build a better 
chart in Excel

Decluttered Excel Templates from 
Storytelling with Data

Work from simple, decluttered templates, taking 
the guesswork out of Excel

Excel Tutorials from Ann Emery Learn how to improve your charts through short 
video tutorials

Build a better 
chart using an 
online tool

Visage | visage.com
Piktochart | piktochart.com

Design web-embeddable charts and graphs with 
simple hover features

Create an icon 
matrix

Piktochart | piktochart.com Use the charts feature to create icon matrices with 
the Piktochart icon library

Build it yourself with icons from The 
Noun Project

Search for a free icon and use PowerPoint to 
replicate, recolor and manipulate the image.

Create a simple 
map

Tableau | tableau.com Create filled maps with publicly available data. can 
read geocoordinates and layers on 
OpenStreetMaps to map towns, cities, districts, 
states, and countries. 

Piktochart | Piktochart.com Create basic maps for embedding in web content 
or including in infographics.

Develop an 
infographic

Piktochart | Piktochart.com 
Infogr.am | Infogr.am

Use web-based tools with infographic templates 
and flexible interfaces for developing graphics for 
web, social media, or print. Both offer embeddable 
images with tooltip features.
Learn how! Coursera Infographic Design (free!) 
coursera.org/learn/infographic-design/
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http://labs.juiceanalytics.com/chartchooser
http://blog.visual.ly/graphic-continuum/
http://www.storytellingwithdata.com/2012/02/no-more-excuses-for-bad-simple-charts.html
http://annkemery.com/excel/
http://www.visage.com/
piktochart.com
piktochart.com
http://www.nounproject.com/
tableau.com
http://www.piktochart.com/
http://www.piktochart.com/
http://www.infogr.am/
https://www.coursera.org/learn/infographic-design/


RECOMMENDED RESOURCES CONTINUED
For building visualizations

If you want to… Check out… So you can…

Create a social 
media graphic

Canva | Canva.com
Pablo | pablo.buffer.com

Create quick graphics with templates sized for 
specific social media types.

Create a GIF of 
your chart

Sketch | sketchapp.com ($99, for 
Mac only)

Creating animated charts and graphs can improve 
how you communicate a data story
Learn how! blog.visual.ly/animated-gif-
infographics/ or freshspectrum.com/gifs/

Develop a highly 
visual report

Slidedocs | duarte.com/slidedocs
Use free editable templates you can use in 
PowerPoint and design recommendations

Develop a 
dashboard

Excel

Useful when sharing dashboards across different 
people and locations, since most people have 
Excel.
Learn how! 
youtube.com/watch?v=9NUjHBNWe9M

Tableau | tableau.com 

Develop interactive dashboards for large (or 
small) datasets that integrate maps, graphs, 
tables, and more, with embedded visual best 
practices.

Microsoft Power BI 
powerbi.microsoft.com

Develop basic dashboard using a free, 
downloadable tool  with some of the design best 
practices of Tableau
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canva.com
https://pablo.buffer.com/
http://www.sketchapp.com/
http://blog.visual.ly/animated-gif-infographics/
http://freshspectrum.com/gifs/
http://www.duarte.com/slidedocs
https://www.youtube.com/watch?v=9NUjHBNWe9M
tableau.com
powerbi.microsoft.com

